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A. Introduction and Power On 

The Kiwi Matrix HD Ink Jet System allows the user to print messages 
that have been generated using the MessageGen Application on the PC. 
To edit or create messages, use the MessageGen App for the PC. 
Messages to be printed must be saved to the MicroSD Card and inserted. 

Before powering on the Kiwi Matrix HD Ink Jet System, the user 
must ensure the following are connected: 

1) Kiwi MicroSD Card 
2) Encoder (for printing with external encoder) 
3) Photocell (for external ToF trigger) 

Powering on: 

Connect the power cord to begin using the Kiwi Matrix HD 
Ink Jet System. When boot-up is complete, the user will be 
brought to the “Home” screen, where they will be able to 
select a message to print. 
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B. Guide to Quick-Start Printing 

Quick-start printing: 

1) Power on the Kiwi Matrix HD Ink Jet System 
2) If purchased and required for application connect external 

encoder to the printer and set wheel on conveyor. 
3) Select the desired “Message File” to print. 
4) Select “Print.” 
5) “End Job” can be selected to quit the print job.  

 

 
C. Kiwi Matrix HD Ink Jet System Menu Tree 

To traverse the Kiwi Matrix Menu, use the arrows on the keypad or the 
directional keys of a USB keyboard. For the keyboard to function, it 
must be plugged in prior to powering on the system. Note: Arrow keys 
may be used for traversing. To select an action or a setting, press 
the “Select” button on the keypad or press “Enter” using the keyboard. 

Menu/Info Bar is the blue icon bar located at the left most portion of 
screen. It allows the user to navigate the menu tree from any page. 

 

  D.  Home is where all the saved Message Files can be found.  

Selecting a Message File prompts the user to begin “Print.”  
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Print begins the print job. After starting a print, user is prompted 
with: 

 End Job will abort the current job 

 Edit allows the user to modify message text  

 

  E.  Settings represented by a gear wheel. Here, the user can 

modify Configurations for the System and for Printing. 

 

 F.  System Config is where the user can access and change system 
settings. 

 

Time Date is where the user can change the time and date on 
the printer which will be used for messages printing 
calendar and time objects. 

Language is set to English. 

Units are set to Imperial. 

About provides information on the Version, Product Name, 
Serial Number, and Print Head Information. 

 Print Head Info displays ink type and serial number. 
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System Restore will prompt the user for a factory reset. 
This will NOT erase messages but all settings and 
configurations will be restored. 

______________________________________________________________________ 

  G.  Print Configuration is where the user can change print related 
settings. 

 

Direction/Orientation allows the user to change the 
direction and orientation of the image being printed. 
Please refer to the following table for the proper setting.  
If the sensor is on the wrong side or need to be changed. 
The sequence of the wiring from top to bottom is blue, 
black and brown. 

 

Paper Direction Left-to-Right 

 

Right-to-Left

 
Forward 

 

 
 

Forward Upside-down 

 

 

Reverse  

 
Reverse Upside-down  
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 H. Encoder Speed/Res allows the user to select between using an 
Internal and External encoder. The external encoder requires an 
encoder wheel on the conveyor. It is the most accurate way to print 

 

Internal encoder allows the user to print without using an encoder    
wheel. After selecting the print mode, user must then select the 
encoder speed.  

Note: this mode is not recommended for 
barcodes. For printing with internal 
encoder, it is recommended that densities 
between 6.25-25% are used. This will remove 
any ghosting effect in the prints. 

  
Internal Encoder Speed 

Print Mode Resolution Max speed (inches/sec) Max speed (feet/min)  
Draft 300 dpi 36 inches/sec 180 ft/min 
Better 600 dpi 18 inches/sec  90 ft/min 
Best 1200 dpi  9 inches/sec  45 ft/min 
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I. Density allows the user to choose between 16 different densities 
ranging from 6.25-100%. 

Note: for printing with internal encoder, it is 
recommended that densities between 6.25-25% are used. 
This will remove any ghosting effect in the prints. 

______________________________________________________________________ 

J.  Message Settings allows for editing Shift Codes and Rollover Hour 

Shift Code is a message object that changes based on what 
time the system is set to. Up to 5 shift codes may be 
created and each one may hold up to 4 characters. Under 
this branch of the Message Settings menu, users may edit 
shift codes and their designated printing times. 

Ex: If shift “AB” is set to print at “14:00” and shift 
“YZ” is set to print at “17:00,” the message with a 
shift code object will print “AB” from 14:00 to 16:59. 
At 17:00, the shift code will switch to “XY” and this 
will be the message printed until 13:59 the next day. 

Rollover Hour is a message object that dictates what time 
the any calendar object in printed messages roll into the 
current date. Rollover Hours are configurable to half-hour 
increments. 

Ex: If today is January 1st and the rollover hour is 
set to 5:00 AM, the printer will print “December 31st” 
until 4:49 AM. At 5:00 AM, the printer will begin 
printing the date “January 1st.” 

 K.  Security allows for the user to lock or unlock message editing 
and changes to settings. The default passcode is “0000” 

Note: if the passcode is lost, the passcode may be reset by 
entering “argus” into the Change Passcode window. 

 Purge may be used to service the print head.  

Encoder Info is represented by a Letter and a Number. 
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 I/E – “Internal” or “External” 

## – Encoder speed. Speed will read “0” prior to initiating 
the first print.  

Print Head Status is displayed under the Encoder Info icon. 
If a valid print cartridge is sensed, the icon will display ink 
level. If no valid cartridge is detected, the icon displayed will 
be an “X” in a red circle. 

 

 L. Default Configurations 

Encoder: External. Better. 
Maximum speed using “Better Mode” in this version is about 
inches/sec. For printing at a higher speed, switch to “Draft 
Mode” in “Print Config” 

ToF: Internal. 2.5 inch trigger delay. 

Density: 50% 

 

M. Notes 

-Do not change any settings while in the middle of a print job. 
To change settings, ensure that a job is not running. Attempting 
to change settings during a job will result in no setting 
changes. 

-USB keyboard must be connected prior to power-up. 

-MicroSD card must be inserted to boot up the Kiwi Matrix HD Ink 
Jet System. 

-Internal Encoder is not recommended for barcode printing.  

-To track speed, ensure that the encoder wheel is set on the 
conveyor. 

-If settings are not showing any sign of change while outside of 
a print job, ensure that security has been turned off to allow 
for settings changes. 
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Kiwi Matrix HD Ink Jet System 

 

Kiwi Matrix MessageGen 
Application 
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A. Introduction  

The Kiwi Matrix MessageGen Application is used to create and edit 
messages to be printed on the Kiwi Matrix HD Ink Jet System. The 
MessageGen Application is programmed onto the MicroSD card provided 
with the Kiwi Matrix HD Ink Jet System under “Run Matrix HD”. Messages 
stored on the card may be moved between a PC and Ink Jet System for 
editing and printing. 

The MessageGen Application allows the user to modify messages and 
print settings that may also be modified on the Ink Jet System. 
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B. Kiwi MessageGen Menu Bar 

To open the Kiwi MessageGen Application, insert the SD card into a PC. 
If prompted to “format disk,” click “No.” Proceed to open the SD Card 
titled “Kiwi Coders” and double-click on “Run Matrix HD” to open the 
application. 

Menu/Info Bar consists of the menu items located at the top of the 
application screen. They include: 

 File 

Edit 

 Configuration 

 Shift Codes 

 Ruler 

Refer to the following pages for details on each of the Menu 
functions. 
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B.1 File 

The “File” tab allows the user to: 

1) Create new messages 
2) Save all messages 
3) Close the Kiwi MessageGen application 

 

B.2 Edit 

The “Edit” tab allows for basic object manipulation such as: 

1) Cut 
2) Copy 
3) Paste 
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B.3 Configuration 

The “Configuration” tab brings up a window that allows the user to  

 

Direction/Orientation allows the user to change the 
direction and orientation of the image being printed. 
Please refer to the following table for the proper setting. 

Paper Direction Left-to-Right 

 

Right-to-Left

 
Forward 

 

 
 

Forward Upside-
down 

 

 

Reverse  

 
Reverse Upside-
down 
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Print Resolution allows the user to define the resolution for 
messages to be printed at.  

Rollover Hour is a message object that dictates what time the any 
calendar object in printed messages roll into the current date. 
Rollover Hours may be enable or disabled by using the check-box 
situated next to the time. 

 

Repeat Print applies for when the user selects the Internal 
trigger. This setting may be selected on the Kiwi Matrix HD 
printer.  

 

Configuration Defaults: 

Configuration Value 
Print Orientation Forward 
Print Resolution 300 DPI 
Rollover Hour 12:30 - disabled 
Repeat Print 1 inch 

 

  

Print 
Mode 

Resolution Max speed 
(inches/sec) 

Max speed 
(feet/min) 

Draft 300 dpi 36 inches/sec 180 ft/min 

Better 600 dpi 18 inches/sec 90 ft/min 
Best 1200 dpi 9 inches/sec 45 ft/min 
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B.4 Shift Codes 

Shift Codes allow for messages to be printed that change based on 
the time of day a message object that changes based on what time 
the system is set to. Up to 5 shift codes may be created and each 
one may hold up to 4 characters.  

Ex: If shift “AB” is set to print at “14:00” and shift “YZ” 
is set to print at “17:00,” the message with a shift code 
object will print “AB” from 14:00 to 16:59. At 17:00, the 
shift code will switch to “XY” and this will be the message 
printed until 13:59 the next day. 

Shift codes may be enabled by populating the check boxes.  
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B.5 Ruler 

The “Ruler” tab provides the option for users to select a ruler that 
uses inches or centimeters. 

 

 Default: 

Configuration Value 
Units Inches 

 

Inches 

 

 

Centimeters 
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C. Message Objects 

The Kiwi MessageGen Application, Objects may be created by clicking on 
any of the seven icons on the “Message Object Toolbar” 

Once the message objects are created, they can be positioned through 
coordinates that can be typed in the component editor at the bottom of 
the screen. Objects may also be dragged and dropped to desired 
positions. 

The component editor at the bottom of the screen may be used to 
manipulate object components such as font size, date format, etc. 

When a component is outside of the print zone, red will fill the 
preview window. With a red preview window, messages will still print 
but any objects outside of the print zone will be cropped. 

  C.1 Image 

Image objects may be imported by clicking on the image icon. 
Clicking the icon will open a window for the desired image to be 
selected. Accepted file types for import include: *.jpg *.jpeg 
*.gif *.bmp 

Once imported, images may be scaled according to their original 
size in the component editor. 

 

  C.2 Text 

Text objects can be created by clicking on the text icon. 

Fonts include: 

 Bitstream Vera Sans Mono 
 Times New Roman 
 Dejavu Sans 
 Ariel 
 Bitstream Vera Serif 
 Dejavu Serif 
 Bitstream Vera Sans 
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Text can be edited in the “Message” box located in the component 
editor. To update the message, press the “Enter” key on the 
keyboard. 

Components that may be edited include: 

 Message 
Font Type 

 Font Size 
 Message position 
 
 

  C.3 2D Barcode 

There are 9 different 2D barcodes that can be generated using the 
Kiwi MessageGen app. To create a 2D barcode, click on the 2D 
barcode icon on the “Message Object Toolbar” and click on the 
barcode generated in the preview screen. 

 

  C.4 Barcode 

Various barcode types can be generated and edited. Barcode types 
include: 

 INTER25 
 Code 39 
 EAN 8  
 EAN 13 
 SSCC 18 
 Codabar 
 Code 128 
 UPC A 
 UPC E 
 SCC 14 
 
To edit barcodes, enter a string in the “Barcode Value” box in 
the component editor. Certain barcodes contain character 
restrictions and/or require specific string lengths. 

 

  C.5 Counter 
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The counter object generates a number that changes based on each 
new print (i.e. each print trigger may increment the counter). 
The counts reset at the end of every print job. 

Components that can be configured include: 

1) The number of placeholders 
2) Initial value 
3) Repeat (how many times a count is printed) 
4) Increment (number of integers that can be jumped) 

 

  C.6 Calendar 

Calendar objects allow the user to print messages with dates and 
times. Dates may be offset to either add or remove days. For a 
negative offset, use a minus sign (-). Using the component 
editor, calendar objects may be repositioned and font size may be 
changed. 

To change the date and time format, open the “Format” dropdown 
menu in the component editor and select the desired format. 

 

  C.7 Shift Codes 

Shift code objects may be positioned and font size may be 
changed. To modify the shift codes and shift times, please refer 
to the “Menu Bar” located at the top of the MessageGen 
Application window. 
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D. Quick-Start Message Generation 

Quick-start message generation and editing: 

1) Insert the MicroSD Card provided by Kiwi Coders into a PC. 
 

2) If requested to reformat drive, click “Cancel” 

 

 
3) Open the SD Card using a File Menu 
 
4) Double-click on the application titled “MessageGen” 
 
5) Click on the “New Message” icon. 
 
6) Messages may now be created, edited, and saved. 

 


